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RFID-Sensor Technology with  
RF210R IO-LINK on ET 200SP  
and SIMATIC S7-1500 

1 Goal 

The following pages show how an RF210R IO-Link RFID-Sensor can be put into operation on an 

IO-Link module in a project with SIMATIC S7-1500 and ET 200SP and how data can be written 

and read to mobile data media using the blocks from the "IOL_READ_WRITE_DATA_LIB_V3.1" 

library. Read and write operations are performed via a visualization on a SIMATIC TP700 

Comfort panel, which must also be created. 

2 Requirement 

This chapter builds on the chapter Distributed Hardware Configuration with SIMATIC S7-1500 

and ET 200SP on PROFINET. To perform the work in this chapter, you can use the following 

project, for example:  

"SCE_EN_012-201 Distributed Hardware Configuration S7-1500 ET 200SP PN…..zap15". 

You also need previous knowledge about the basics of programming in the TIA Portal, handling 

data blocks and creating a process visualization for a SIMATIC Panel TP700 Comfort with 

WinCC Advanced. 
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3 Required hardware and software 

1 Engineering station: requirements include hardware and operating system  

(for additional information, see Readme on the TIA Portal Installation DVD) 

2 SIMATIC STEP 7 Professional software in TIA Portal – as of V15.1 

3 WinCC Advanced software in TIA Portal – as of V15.1 

4 Software S7-PCT Port Configuration Tool – as of V3.5 

5 SIMATIC S7-1500 controller, e.g. CPU 1516F-3 PN/DP –  

as of firmware V2.5 with memory card  

6 ET 200SP Distributed IO for PROFINET with 16DI/16DO as well as 2AI/1AO and IO-Link 

Master  

Example configuration: 

Interface module IM155-6PN HF with BusAdapter BA 2xRJ45 

2x IO module 8x digital input DI 8x24VDC HF 

2x IO module 8x digital output DQ 8x24VDC/0.5A HF 

2x IO module 2x analog input AI 2xU/I 2, 4-wire HS 

IO module 2x analog output AQ 2xU/I HS 

Communication module IO-Link Master CM 4xIO-Link as of firmware V2.1 

Server module 

7 Readers of the RF200 Family with IO-Link interface, e.g. SIMATIC RF210R IO-Link with  

reader cable and RFID-Transponder 

8 SIMATIC Panel TP700 Comfort 

9 Ethernet connection between engineering station and controller,  

between controller and ET 200SP distributed IO and  

between ET 200SP distributed IO and Panel TP700 Comfort 
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4 Theory 

The data of an RFID-Transponder in this document is to be read and write accessed. 

For this, we use the RF210R IO-Link RFID-Sensor on an IO-Link Master CM 4xIO-Link. This 

must be commissioned with the S7-PCT Port Configuration Tool software. 

The program uses blocks from the "IOL_READ_WRITE_DATA_LIB_V3.1" library. 

The basic information from the SIEMENS manuals is provided here. 

4.1 IO-Link Master CM 4xIO-Link 

IO-Link is a point-to-point connection between a master and a device. Both conventional and 

intelligent sensors/actuators in proven 3-wire technology can be connected to the IO-Link Master 

via unshielded standard cables. Switching status and data channel are designed in proven 24 V 

DC technology. 

4.1.1 Technical properties 

The IO-Link Master module, CM 4xIO-Link, has the following technical features: 

– Serial communication module with 4 ports (channels) 

– SIO mode (standard IO mode) 

– IO-Link Master according to IO-Link Specification V1.1 

– Time-based IO (time stamping) as of FW V2.0 

– Data transmission rates COM1 (4.8 kbaud), COM2 (38.4 kbaud), COM3 (230.4 kbaud) 

– Suitable for connecting up to 4 IO-Link devices (3-wire connection) or  

4 standard encoder or standard actuators  

– Cable length unshielded, maximum 20 m 

– Programmable diagnostics function by port 

– Automatic backup of the master and device parameters via electronic  

coding element 

– The IO-Link port configuration is performed with the S7-PCT Port Configuration Tool 

– Variable address range of the IO data with up to 32 bytes inputs and 32 bytes  

outputs as of FW V2.0 / 144 bytes inputs and 128 bytes outputs as of FW V2.1 

– IO-Link port configuration without S7-PCT as of FW V2.2  
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4.1.2 Description of the IO-Link Master CM 4xIO-Link 

 

1) Module type and name 

2) LED for diagnostics 

3) QR code 

4) Connection diagram 

5) LEDs for status and error displays 

6) LED for supply voltage 

7) Function class 

 

8) Color coding module type 

9) Function and firmware version 

10) BU type 

11) Color code for selecting the  

color-coded labels 

12) Article number 

 

4.1.3 Status and error displays 

 

1) Diagnostics (DIAG) (green/red) 

2) Port status/IO-Link status (Cn) (green) 

3) Channel status in SIO modus (QN) (green) 

4) Port error (Fn) (red) 

5) Supply voltage L + (PWR) (green) 
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4.1.4 Device exchange IO-Link Master CM 4xIO-Link with electronic coding 

element 

When you remove the communication module from the BaseUnit, part of the electronic coding 

element remains plugged into the BaseUnit. The parameters of the IO-Link Master CM 4xIO-Link 

as well as the parameters of the IO-Link devices are stored in this part. A newly inserted (not yet 

configured) IO-Link Master takes over the parameters from the electronic coding element. 

 

Note:  

– Only disconnect and plug in the IO-Link Master CM 4xIO-Link communication module when it 

is de-energized. If you plug the IO-Link Master CM 4xIO-Link communication module when it 

is energized, this can damage the ET 200SP distributed IO system and thus create 

dangerous conditions in your system.  

 

You can see more details in the manuals at support.automation.siemens.com 

  

http://support.automation.siemens.com/
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4.2 S7-PCT Port Configuration Tool Software 

IO-Link Master modules from SIEMENS and IO-Link devices from any manufacturer can be 

configured with the S7-PCT Port Configuration Tool. The parameter data of the IO-Link devices 

can be set, modified, copied and saved in the TIA Portal project here.  

The S7-PCT Port Configuration Tool is called via the hardware configuration of the IO-Link 

Masters.  

 

4.2.1 Properties of the S7-PCT Port Configuration Tool 

Properties of the S7-PCT Port Configuration Tool 

– Available free-of-charge as download in the Internet 

(support.industry.siemens.com/cs/document/32469496) 

– Import IODD (IO Device Description) for IO-Link devices from different manufacturers 

– Configuration screens (tabs) in S7-PCT with plain text and product image directly from the 

IODD of the certified device 

– Central data storage of all project data in the TIA Portal project 

– Extensive test and diagnostic functions 

– Read identification data from the devices 

– Read back device information including parameter settings 

 

Ensure that the current IODD files (IO-Link V1.1) are included in the catalog. If they are not, 

import them via the menu "Tools" > "Import IODD".  

You can find the latest IODD files on the DVD "RFID-Systems Software & Documentation" 

(6GT2080-2AA20) or on the pages of Siemens Industry Online Support 

support.industry.siemens.com/cs/products?dtp=Download&mfn=ps&pnid=14972&lc=en-DE. 

 

You can see more details in the manuals at support.automation.siemens.com 

  

https://support.industry.siemens.com/cs/document/32469496
https://support.industry.siemens.com/cs/products?dtp=Download&amp;amp;mfn=ps&amp;amp;pnid=14972&amp;amp;lc=en-DE
http://support.automation.siemens.com/


Learn-/Training Document | TIA Portal Module 102-101, Edition 2019 | Digital Industries, FA 

For unrestricted use in educational and R&D institutions. © Siemens 2019. All rights reserved. 6   

sce-102-101-rfid-sensor-rf210r-io-link-et200sp-s7-1500-r1901-en.docx    

4.3 SIMATIC RF210R IO-Link Reader 

SIMATIC RF200 IO-Link is an inductive identification system compatible with the ISO 15693 

standard, which was specially designed for use in industrial production for control and 

optimization of material flow. Readers can be used below the fieldbus level with the IO-Link 

communication interface. 

SIMATIC RF200 IO-Link is a simple and cost-effective solution for RFID-Applications. 

 

 

1) RF200 IO-Link interface 

2) LED operating display 

 

The operating states of the reader are indicated by the LED. The LED can be green, red or 

yellow and the states off, on or flashing. 

The IO-Link reader reads either the UID or user-specific data of a transponder and maps this into 

cyclically updated process data. User-specific data can also be written. 

This data can be imported via the IO-Link Master from a PC or a controller. 
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4.3.1 Technical specifications of the RF200 IO-Link-Reader 

The IO-Link reader has the following features: 

– Point-to-point communication, no address setting of the IO-Link device required 

– Supports only IO-Link Masters according to specification V1.1 

– IO-Link transmission speed 230.4 Kbps 

– Maximum data transmission rate wireless transmission 26.6 Kbps 

– Process data in the process image: 32 bytes of input and 32 bytes of output 

– User data in the process image: 28 bytes of input and 28 bytes of output 

– Typical transfer time for user data per byte 

- for write access (for 28-byte block) 3.6 ms/byte 

- for read access (for 28-byte block) 2.4 ms/byte 

– Transmission of service data in parallel to process data 

– Parameter upload/download functionality for device exchange (parameter server) 

– SIO mode (reader indicates the presence of a transponder on the data line (C/Q)) 

– IODD file for support of parameter assignment, diagnostics and data access 

– Degree of protection IP67 

– RFID-Operating frequency nominal value 13.56 MHz according to ISO 15693, ISO 18000-3 
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4.3.2 Transmission window and read/write distance 

The reader generates an inductive alternating field. The field is at its greatest near the reader, 

however, the "zero" read/write distance between reader and transponder is not recommended. 

The field strength of the alternating field decreases strongly with the distance to the reader. The 

distribution of the field depends on the structure and geometry of the antennas in the reader and 

transponder. 

The function of the transponder requires a minimum field strength at the transponder, which is 

just reached at a distance Sg (limit distance) from the reader. 

The following figure shows the transmission window of the SIMATIC RF210R reader between 

transponder and reader: 

 

Sa: Working distance between transponder and reader 

Sg: Limit distance (limit distance is the maximum clear distance between  

reader top and transponder, where the transmission just barely works under normal 

conditions). 

L: Diameter of a transmission window. 

SP: Intersection of the transponder's symmetry axis. 

  

Transponder 

Transponder 

Top view 

Transmission window 
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4.3.3 Working in static and dynamic mode 

When working in static mode, the transponder can be operated up to the range of the limit 

distance (Sg). The transponder must be positioned exactly above the reader: 

 

In static mode, the dwell time tv (application-dependent) can be as long as desired. The dwell 

time must be at least until communication with the transponder has been completed. 

Working in dynamic mode is not recommended for RF200 IO-Link. 

4.3.4 Installation guidelines 

Transponders and readers with their antennas are inductive devices. Any kind of metal in the 

vicinity of these devices affects their operation. A few points must be observed during 

configuration and installation: 

– Minimum distance between two readers or their antennas 

– Minimum distance between two adjacent transponders 

– Installation of several readers or their antennas on metal frames or carriers  

for shielding 

– Flush installation of the components in metal reduces the field data; testing is  

recommended for critical applications. 

– Metal-free space for flush installation of readers or their antennas and  

transponders in metal 

– Direct mounting on metal is only permitted with specially approved transponders. 

– When working in the transmission window, it must be ensured that no metal rail 

(or similar) intersects the transmission field. The metal rail would affect the field data. 

  

Transponder 

Transmission 
window 



Learn-/Training Document | TIA Portal Module 102-101, Edition 2019 | Digital Industries, FA 

For unrestricted use in educational and R&D institutions. © Siemens 2019. All rights reserved. 10   

sce-102-101-rfid-sensor-rf210r-io-link-et200sp-s7-1500-r1901-en.docx    

4.3.5 Connecting cable 

The connecting cable has a length of 5 m or 10 m. 

Structure of the connecting cable between IO-Link Master with single-wire connection technology 

and reader: 

IO-Link mode IO-Link side Reader side 

 

 

4.3.6 Pin assignment RF200 reader with IO-Link interface 

Pin 
Pin 
Device end  
4-pin M12 

Assignment 

 

1 24 VDC  

2 reserved  

3 GND  

4 IO-Link data signal or switching output port in SIO mode 

 

4.3.7 Pin assignments of the IO-Link Master from Siemens 

Pin assignment for the CM 4xIO-Link electronic module (6ES7137-6BD00-0AB0) 

Terminal Assignment Terminal Assignment Explanations Color labeling plate  

1 C/CQ1 2 C/CQ2 

• C/Q: Communication signal 

• RES: Reserved, must not be 

used 

• L+: Supply voltage (positive) 

• M: Ground 

 
CC04 

6SE7193-6CP04-2MA0 

3 C/CQ3 4 C/CQ4 

5 RES 6 RES 

7 RES 8 RES 

9 L + 1 10 L + 2 

11 L + 3 12 L + 4 

13 M 14 M 

15 M 16 M 

L+ 24 V DC M Ground 

 

You can see more details in the manuals at support.automation.siemens.com  

3-wire 

Sensor 

brown 

res. 

blue 

black 

SLG connector 
M12, female connector (4-pin) 

http://support.automation.siemens.com/
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4.4 IOL_READ_WRITE_DATA_LIB_V3.1 library (LRfidIOL_V15) 

With the blocks of this library, the RF200 IO-Link Reader (V1.0/V1.1) can be controlled via a very 

simple user interface. 

Tested SIMATIC modules with clearly defined interfaces can be used to implement the task. 

Note: 

– The library is available for the SCE Learn-/Training Document “SCE_EN_102-101_RFID-

Sensor_RF210R_IO-Link_ET 200SP_S7-1500…“ in the projects folder, but can also be 

downloaded from SIEMENS Product Support with the following link: 

support.industry.siemens.com/cs/document/73565887. 

4.4.1 Blocks of the library 

Communication between the CPU and an RF200 reader with IO-Link interface is realized via a 

corresponding IO-Link Master module by reading the corresponding configured address ranges 

(input and output ranges) of the RF200 IO-Link reader.  

The following table lists all blocks belonging to the "IOL_READ_WRITE_DATA_LIB_V3.1 

(LRfidIOL_V15)" library. 

Block  Function  Description/Classification 

LRfidIOL_Read  Read  Function block for reading from the 
transponder.  

LRfidIOL_Write  Write  Function block for writing to the 
transponder.  

LRfidIOL_Antenna  Switching antenna 
on/off  

Function block for switching the antenna 
of an RF200 IO-Link reader on/off.  

 

  

https://support.industry.siemens.com/cs/document/73565887
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4.4.2 FB "LRfidIOL_Read" 

The "LRfidIOL_Read" library block reads a data block from the transponder. The following table 

shows the call interface of the FB "LRfidIOL_Read" library block. 

 Symbol Data type Explantation 

IN
P

U
T

 

excute  BOOL Read job activated at positive edge.  

adrTag  WORD Start address of the data to be read on the 

transponder.  

length  WORD Length of the data that is read from the transponder. 

hwld HW_SUBMODULE Hardware identifier of the IO-Link communication 

module. 

 
portAdr INT Start address of the connected reader (PCT Tool) 

 
Example: Start address 0.0, the value “0” has to be 

entered in PORT_ADR. 

IN
 /
 O

U
T

 

identData Variant Area in the S7-CPU where the read data is stored 

(global data block). 

 

O
U

T
P

U
T

 

done BOOL TRUE if the last job has been completed without 

errors (for one cycle). 

FALSE if a new command is started. 

busy BOOL TRUE if the “LRfidIOL_Read” block is active. 

FALSE if the job was stopped or if an error occurred. 

error BOOL FALSE, if a command was completed without errors. 

TRUE if an error occurs when processing (for one 

cycle). Default value: FALSE 

status DWORD • DW#16#00, if a command was completed without 

errors. 

• In the case of an error (ERROR=TRUE) Hex value 

unequal zero (see Chapter 2.4).  

Remains on this value for one cycle. 

presence BOOL Presence bit. This bit is only set if a transponder is in 

the field of the reader. 
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4.4.3 FB "LRfidIOL_Write" 

The "LRfidIOL_Write" library block writes a data block to a transponder. The following table 
shows the call interface of the FB "LRfidIOL_Write" library block. 
 

 Symbol Data type Explantation 

IN
P

U
T

 

excute  BOOL Enables the write job at positive edge.  

adrTag  WORD Start address of the data to be written on the 

transponder.  

length  WORD Length of the data that is written to the transponder. 

Note: The reader writes at least 4 (V1.0) or 28 bytes 

V1.1 to the transponder. This is why a length larger 

than 4 (V1.0) or 28 bytes (V1.1) has to be chosen.  

hwld HW_SUBMODULE Hardware identifier of the IO-Link communication 

module. 

 
portAdr INT Start address of the connected reader (PCT Tool) 

 
Example: Start address 0.0, the value “0” has to be 

entered in PORT_ADR. 

IN
 /
 O

U
T

 

identData Variant Area in the S7-CPU where the data written to the 

transponder is stored (global data block). 

 

O
U

T
P

U
T

 

done BOOL TRUE if the last job has been completed without 

errors (for one cycle). 

FALSE if a new command is started. 

busy BOOL TRUE if the “LRfidIOL_Write” block is active. 

FALSE if the job was stopped or if an error occurred. 

error BOOL FALSE, if a command was completed without errors. 

TRUE if an error occurs when processing (for one 

cycle). Default value: FALSE 

status DWORD • DW#16#00, if a command was completed without 

errors. 

• In the case of an error (ERROR=TRUE) Hex 

value unequal zero (see Chapter 2.4).  

Remains on this value for one cycle. 

presence BOOL Presence bit. This bit is only set if a transponder is in 

the field of the reader. 
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4.4.4 FB "LRfidIOL_Antenna" 

The FB "LRfidIOL_Antenna" library block switches the antenna of an RF200 IO-Link reader on or 

off. During normal operation, this command is not needed, because the antenna is always 

switched on after the reader is switched on. The following table shows the call interface of the 

library block FB "LRfidIOL_Antenna". 

                                                                                                                                                                                                                                                                            Symbol Data type Explantation 

IN
P

U
T

 

excute  BOOL Enables the read/write job. 

Responds to a positive edge.  

adrTag  BOOL TRUE: Switch antenna on. 

FALSE: Switching antenna off.  

hwld HW_SUBMODULE Hardware identifier of the IO-Link communication 

module. 

 
portAdr INT Start address of the connected reader (PCT Tool) 

 
Example: Start address 0.0, the value “0” has to be 

entered in PORT_ADR. 

O
U

T
P

U
T

 

done BOOL TRUE if the last job has been completed without 

errors (for one cycle). 

FALSE if a new command is started. 

busy BOOL TRUE if the “LRfidIOL_Read” block is active. 

FALSE if the job was stopped or if an error occurred. 

error BOOL FALSE, if a command was completed without errors. 

TRUE if an error occurs when processing the routine. 

status DWORD • DW#16#00, if a command was completed without 

errors. 

• In the case of an error (ERROR=TRUE) Hex value 

unequal zero (see Chapter 2.4). 

 Remains on this value for one cycle. 

presence BOOL Presence bit. This bit is only set if a transponder is in 

the field of the reader. 

 

You can find more details in the documents from the entry page of the application example at 

support.industry.siemens.com/cs/document//73565887. 

https://support.industry.siemens.com/cs/document/73565887
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5 Task 

The hardware configuration from the "SCE_EN_012-201 Distributed hardware configuration with 

SIMATIC S7-1500 and ET 200SP on PROFINET" learning/teaching manual is to be extended by 

the "CM 4xIO-Link" IO-Link Master. The "SIMATIC RF210R IO-Link" RFID-Reader is to be 

connected to port 1 and commissioned there. 

Place the IO-Link Master "CM 4xIO-Link" on slot 8. The server module is moved to slot 9 

beforehand 

Set the address range for the IO-Link Master starting at 10.  

Module Order number Slot Address range 

CM 4xIO-Link 6ES7 137-6BD00-0AB0 8 10…41 

Table1: IO-Link Master of the ET 200SP 

Device Order number Port Address range 

RF210R IO-Link 6GT2 821-1BC32 1 10.0…41.7 

Table2: Sensors on the IO-Link Master 

Create a program with which the following user data can be read and written  

on an RFID-Transponder with the SIMATIC RF210R IO-Link reader: 

Job number (data type: Integer) 

Date (Data type: Date) 

Time of day (Data type: Time_Of_Day) 

Number_of_plastic_parts (data type integer) 

 

The program is to be operated with a SIMATIC TP700 Comfort Panel. 
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6 Planning 

The source project with CPU1516F and ET 200SP is to be retrieved. 

The hardware is already specified for this project. Therefore, no selection is necessary. 

The BaseUnit is also important for the extension of the ET 200SP by the "CM 4xIO-Link" IO-Link 

Master. This determines whether the potential is taken from the left terminal (dark BaseUnit), or 

whether a new power supply must be connected, thus creating a new potential group (light 

BaseUnit). The BaseUnit included in the Trainer packages are all of the type BU15-P16+A0+2D 

(6ES7193-6BP00-0DA0), so the light version is preset. 

Before configuring the IO-Link system with the "S7-PCT Port Configuration Tool", the hardware 

configuration is saved, compiled and loaded. The ET 200SP is assigned the PROFINET device 

name. 

Any errors present can be detected during compilation and incorrect modules can be detected 

when the controller is started (only possible when hardware is present and structured identically). 

The S7-PCT Port Configuration Tool is required to configure the IO-Link system with the 

"RF210R IO-Link" IO-Link device. 

Reading and writing should be programmed in a function block (FB) "Read_Write_RFID_Data".  

The blocks from the SIEMENS library "IOL_READ-WRITE_DATA_LIB_V3.1" are used to read 

and write the data on the RFID-Transponder. 

These can only read and write data packets in the format array of the Byte type, whereby the 

data length of this raw data should correspond to the data length of the specified user data. 

In addition, the 2 data blocks "Data_Ident_Read" and "Data_Ident_Write" are required for data 

management. Since both blocks contain the same data structures, these structures are created 

beforehand as raw data and user data user data types. 

The "Serialize" and "Deserialize" blocks can be used for data transfer between raw data and user 

data.  

For visualization and operation in the SIMATIC TP700 Comfort Panel, an "RFID-Data" image is 

created. There, the user data from the "Data_Ident_Read" and "Data_Ident_Write" data blocks 

are displayed, whereby the values can also be changed for writing. 

If an RFID-Transponder is located in the area of the RF210R IO-Link RFID-Reader, the buttons 

for reading and writing the data are displayed. 

The result is archived to back up the working version. 
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7 Structured step-by-step instructions 

You can find instructions on how to carry out planning below. If you already have the necessary 

prior knowledge, the numbered steps are sufficient. Otherwise, simply follow the steps in the 

instructions. 

7.1 Retrieving an existing project 

→ Before you can expand the project "SCE_EN_012-201 Distributed Hardware Configuration 

S7-1500 ET 200SP PN_R1807.zap15" from the chapter "SCE_EN_012-201 Distributed 

Hardware Configuration with SIMATIC S7-1500 and ET 200SP on PROFINET", you must 

retrieve it. To retrieve an existing project that has been archived, you must select the relevant 

archive with → Project → Retrieve in the project view. Confirm your selection with "Open".  

(→ Project → Retrieve → Select a .zap archive … → Open) 

 

 

→ The next step is to select the target directory where the retrieved project will be stored. 

Confirm your selection with "OK". (→ Target directory … → OK) 
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→ Save the opened project under the name 102-101_RFID-Sensor_RF210R_IO-Link.  

(→ Project → Save as … → 102-101_RFID-Sensor_RF210R_IO-Link → Save) 
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7.2 ET 200SP: Inserting and configuring the IO-Link Master 

→ Now open the device view of the "SortingStation01" device by opening the device 

configuration and select the "SortingStation01 [IM 155-6 PN HF]" device. (→ Device 

configuration → SortingStation01 [IM 155-6 PN HF]) 

 

→ Use drag & drop to move the server module to slot 9 and insert the "CM 4xIO-Link" module 

with the correct firmware from the catalog into slot 8.  

(→ Server module_1 → Hardware catalog → Communication modules → IO-Link Master → 

CM 4xIO-Link → 6ES7 137-6BD00-0AB0 → V2.2) 
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→ In the properties of the IO-Link Master, select "Enable new potential group (light 

BaseUnit)" and set the IO addresses of the IO-Link Master to "I 10...41" and "Q 10...41" in 

the device overview. (→ CM 4xIO-Link_1 → Potential group → Enable new potential group 

(light BaseUnit) → Device overview → CM 4xIO-Link_1 → I address 10…41 → Q address 

10…41) 
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7.3 Loading the hardware configuration and assigning device 

names 

→ To save your project, select the  button in the menu. The complete controller 

should then be loaded, as already described in the modules for hardware configuration . 

(→  → ) 

 

→ To obtain an overview of the assigned addresses within a project, you can click the " " icon 

in the "Network view". (→ Network view →  Show addresses)  
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→ In order for the controller, here the CPU1516F-3 PN/DP, to find the assigned PROFINET 

devices in the network, the device name must still be assigned to it. This is done by selecting 

the network that connects the devices in the "Network view" and then clicking on the " " 

icon. (→  Assign device name) 

 

Note: 

– The IP addresses set in the project are automatically assigned to the devices by the 

controller when the communication connection is established. 
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→ Online access must be correctly set in the dialog for assignment of the PROFINET device 

names. Each device can then be selected individually and filtered by devices of the same 

type. When a new device is connected the first time, the list must be updated again. (→ 

PROFINET device name: sortingstation01 → Type of PG/PC interface: PN/IE → PG/PC 

interface: here: Intel(R) Ethernet Connection I217-LM →  Only show devices of the same 

type → ) 

 

→ The correct device must be always be clearly determined by the MAC address printed on the 

device before the name is assigned. To check this, you can also have the LEDs on the 

device flash. (→  → ) 
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→ The successful assignment of the PROFINET device name and the IP address (through the 

previously loaded CPU) should still be checked before the dialog is closed. (→

) 
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7.4 Inserting and configuring RF210R IO-Link RFID-Sensor with 

device tool (S7-PCT) 

→ Now select the IO-Link Master "CM 4xIO-Link_1" with a right-click in the device view of the 

"Sorting Station01" device and start the device tool (S7-PCT) for IO-Link configuration. (→ 

Device view → SortingStation01 → CM 4xIO-Link_1 → Start device tool → S7-PCT → Start) 
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→ Select the "SIMATIC RF210R IO-Link" RFID-Reader from the catalog of the S7-PCT 

software in the "IO Link V1.1" folder under "SIEMENS AG" / "SIMATIC Ident" and drag it to 

port 1 of the IO-Link Master. (→ IO Link V1.1 → SIEMENS AG → SIMATIC Ident → SIMATIC 

RF210R IO-Link) 

 

Note: 

– In the S7-PCT software, there is no option to save the configuration in the TIA Portal project. 

This happens automatically as soon as the S7-PCT software is closed again. 

– If the "SIMATIC RF210R IO-Link" component is not available in the appropriate version in 

the catalog, you can use the → Tools menu to import it as → IODD. IODD V1.1 is available 

in the SCE Learn-/Training Document “SCE_EN_102-101_RFID-Sensor_RF210R_IO-

Link_ET 200SP_S7-1500…“ in the projects folder or using the following link: 

support.industry.siemens.com/cs/document/109750193 SIEMENS Product Support. 

 

  

https://support.industry.siemens.com/cs/document/109750193
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→ Switch to the sub-folder "[1]SIMATIC RF210R IO-Link" and, in the "Parameters" tab there, 

change the "Mode" of the reader to "Acquisition user data".  

(→ [1] SIMATIC RF210R IO-Link → Parameters → Mode → Acquisition user data) 
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→ When you return to the folder "[Slot 8] CM 4xIO-Link_1" and select the "Addresses" tab 

there, you can select  "  Show PLC addresses" and "  All ports" to see the process data 

of the RFID-Reader from the point of view of the PLC. (→ [Slot 8] CM 4xIO-Link_1 → 

Addresses →  Show PLC addresses →  All ports) 

 

→ Now select the folder "[Slot 8] CM 4xIO-Link_1" and click "  Load with Devices". The 

parameters are then written to the IO-Link Master and the RFID-Reader. (→ [Slot 8] CM 

4xIO-Link_1 → ) 
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→ Successful loading of the parameters is now displayed. "Exit" the "S7-PCT" tool and confirm 

the saving of the parameters with "Yes". (→ File → Exit → Yes) 
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7.5 Creating data types for raw data and user data 

→ Under PLC data types, create a "User_data_type_user_data" data type with the following 

structure. (→ PLC data types → Add new data type → User_data_type_user_data) 

 

→ Under PLC data types, create a new "User_data_type_raw_data" data type with an array of 

the "Byte" type and a length of [1..10]. (→ PLC data types → Add new data type → 

User_data_type_raw_data) 
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7.6 Data blocks for the RFID-Read and write data 

→ Create a "Data_Ident_Read" global data block. Under the use of the 

"User_data_type_raw_data" and "User_data_type_user_data" data types, define its 

structure as shown here. (→ Add new block → Data block → Global DB → Data_Ident_Read 

→ Raw data → User_data_type_raw data → User data → User_data_type_user_data) 
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→ Create a "Data_Ident_Write" global data block. Under the use of the 

"User_data_type_raw_data" and "User_data_type_user_data" data types, define its 

structure as shown here. Save your project again. (→ Add new block → Data block → Global 

DB → Data_Ident_Write → Raw data → User_data_type_raw_data → User data → 

User_data_type_user_data → ) 

 

Note: 

– When using a CPU with a firmware version older than V2.5, these two data blocks must not 

be optimized data blocks. In the properties of the blocks, this option must be deselected as 

follows: 
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7.7 Blocks from the IOL_READ_WRITE_DATA_LIB_V3.1 library 

→ Switch to the "Global Libraries" view and, right-click to select "Retrieve library" in order to 

retrieve the SIEMENS library "IOL_READ_WRITE_DATA_LIB_V3.1" (LRfidIOL_V15) with 

the blocks for communication with the SIMATIC RF210R IO-Link reader. (→ Global libraries 

→ Retrieve library → IOL_READ_WRITE_DATA_LIB_V3.1 → Open) 

 

 

Note: 

– The library is available for the SCE Learn-/Training Document “SCE_EN_102-101_RFID-

Sensor_RF210R_IO-Link_ET 200SP_S7-1500…“ in the projects folder, but can also be 

downloaded from SIEMENS Product Support with the following link: 

support.industry.siemens.com/cs/document/73565887. 

 

https://support.industry.siemens.com/cs/document/73565887
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7.8 "Read_Write_RFID_Data" function block 

→ Create a "Read_Write_RFID_Data" function block with the function block diagram (FBD) 

programming language and open it. (→ Add new block → Function block → FUP → 

Read_Write_RFID_Data) 
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→ Define the local tags shown here in the "Read_Write_RFID_Data" function block. (→ Static 

→ Temp) 
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→ In the first network, call the "LRfidIOL_READ" block as a multiinstance from the previously 

retrieved global SIEMENS library "LRfidIOL_V15". (→ Global libraries → LRfidIOL_V15 → 

Master copies → S7_1X00 → IOL_V11 → LRfidIOL_READ → Multiinstance → OK) 

 

Note: 

– When selecting the blocks from the SIEMENS "LRfidIOL_V15" library, note the version of the 

CPU used and the version of the SIMATIC RF210R IO-Link reader. 
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→ Connect the "LRfidIOL_READ" block as shown here, whereby the wiring of the IN variable 

"hwId" is best done by a selection via drag & drop in the detailed view of the "standard tag 

table". You also connect the IN variable "identData" by selecting the "Data" array from the 

detailed view of the "Data_Ident_Read" data block using drag & drop.  
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→ In the second network, call the "Deserialize (V2.0)" block from "Instructions" / "Basic 

instructions" / "Move (V2.2)" and connect it as shown here. (→ Instructions → Basic 

instructions → Move operations (V2.2) → Deserialize (V2.0)) 

 

Note: 

– Note the version of the "Deserialize" instruction when selecting. This must be at least V2.0 in 

order to use optimized data blocks. 
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→ In the third network, call the "Serialize (V2.0)" block from "Instructions" / "Basic 

instructions" /"Move (V2.2)" and connect it as shown here. (→ Instructions → Basic 

instructions → Move operations (V2.2) → Serialize (V2.0)) 

 

Note: 

– Note the version of the "Deserialize" instruction when selecting. This must be at least V2.0 in 

order to use optimized data blocks. 
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→ In the fourth network, call the "LRfidIOL_WRITE" block as a multiinstance from the global 

SIEMENS library "LRfidIOL_V15" and connect it as shown here. (→ Global libraries → 

LRfidIOL_V15 → Master copies → S7_1X00 → IOL_V11 → LRfidIOL_WRITE → 

Multiinstance → OK) 

 

Note: 

– When selecting the blocks from the SIEMENS "LRfidIOL_V15" library, note the version of the 

CPU used and the version of the SIMATIC RF210R IO-Link reader. 
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→ Now open the "Main [OB1]" block in FBD and call the "Read_Write_RFID_Data" block in 

the first network. Have the TIA Portal create the "Read_Write_RFID_Data_DB" instance 

data module. Now save the project by clicking " " before you load the 

"CPU_1516F" " ". (→Main [OB1] → FBD → Read_Write_RFID_Data → OK → 

 → ) 
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7.9 Testing the application with the watch table_RFID 

→ Create the "Watch table_RFID" shown here, with access to the user data in the two data 

blocks "Data_Ident_Read" and "Data_Ident_Write" as well as to the static tags "ReaPres" 

/ "HMI_Read" / "WriPres" / "HMI_Write" via the "Read_Write_RFID_Data_DB" instance 

DB (→ Watch and force tables → Add new watch table → Watch table_RFID → 

Data_Ident_Read → Data_Ident_Write → Read_Write_RFID_Data_DB) 

→ Test the reading and writing on the RFID-Transponder by first clicking on "Monitor all " 

in the watch table. Now you can change the user data in the "Data_Ident_Write" data block 

with "Modify once and now ". If it is possible to read from or write to an RFID-

Transponder, this is indicated in tag "WriPres==TRUE" or "ReaPres==TRUE". Now reading 

and writing can be tested with a positive edge at the "HMI_Read" or "HMI_Write" tag. (→ 

 → ) 
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7.10 Accessing data with a Panel TP700 Comfort 

→ Create a TP700 Comfort Panel in your project. (→ Add new device → HMI → SIMATIC 

Comfort Panel → "7" Display → TP700 Comfort → 6AV2 124-0GC01-0AX0 → Device name: 

Panel TP700 Comfort →  Start Device Wizard → OK) 
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→ In the HMI Device wizard, select your configured CPU 1516F as the communication partner 

and "Ethernet" as the interface. Confirm your selection by clicking .  

 

→ In the "Screen navigation" section, create the screen structure displayed below with the 

corresponding screen names. Confirm your selection with a click  

on . 
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→ Open the "RFID-Data" screen and delete the text in the background. 
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→ In this screen, we need 2 "Buttons" with the labels "Write" and "Read". In each case, for 

"Press" create the "Event" "SetBitWhileKeyPressed" and link it to the "HMI_WRITE" and 

"HMI_READ" tags from the "Read_Write_RFID_Data_DB" instance DB. Add "Text fields" 

for description. 
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→ Animate the "Visibility" of the two buttons so that they are only displayed depending on the 

"ReaPres" and "WriPres" tags from the "Read_Write_RFID_Data_DB" instance DB. 
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→ Next, we create 8 "IO fields" by dragging & dropping the 4 tags in the "User data" structure 

from the "Data_Ident_Write" and "Data_Ident_Read" data blocks into our "RFID-Data" 

screen. 
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→ Change the "Type" of the tags read to "Output" and adjust the "Format" of the "IO fields" so 

that the respective sizes can be sensibly displayed. Add "Text fields" for description. 
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→ Once the project has been saved " " and the "TP700 Comfort" panel has been 

loaded " ", the visibility of the "Read" and "Write" buttons indicates that an RFID-

Transponder has been detected by the sensor.  

By clicking on "Read", the values can be read on the transponder and displayed below it. The 

values to be written can be entered in the IO fields under "Write" and then written to the 

RFID-Transponder by clicking on "Write". 
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7.11 Archive the project 

→ To archive the project, select the → "Archive ..." command in the → "Project" menu. 

 

→ Confirm the prompt to save the project if needed with → "Yes". 

 

→ Select a folder where you want to archive your project and save it as a "TIA Portal project 

archive" file type. (→ "TIA Portal project archive" → "SCE_EN_102-101_RFID-

Sensor_RF210R_IO-Link…" → "Save") 
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7.12 Checklist – step-by-step instructions 

The following checklist helps trainees/students to independently check whether all steps of the 

step-by-step instruction have been carefully completed and enables them to successfully 

complete the module on their own. 

No. Description Checked 

1 Program changes successfully performed in the CPU 1516F 
 

2 CPU 1516F successfully compiled without error message 
 

3 CPU 1516F successfully downloaded without error message 
 

4 

Loading of IO-Link Master CM 4xIO-Link and RFID-Sensor 

RF210R IO-Link with device tool (S7-PCT) successfully 

completed 

 

5 
Process visualization for the Touch Panel TP700 Comfort 

successfully created 

 

6 
Touch Panel TP700 Comfort successfully compiled without error 

message 

 

7 
Touch Panel TP700 Comfort successfully downloaded without 

error message 

 

8 
Writing of user data with panel on RFID-Transponder 

successfully completed 

 

9 
Reading of user data with panel from RFID-Transponder 

successfully completed 

 

10 Project successfully archived 
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8 Exercise 

8.1 Task – Exercise  

In this exercise, the function block (FB) "Read_Write_RFID_Data" is to be created and 

converted to a library-compatible block and a "DATE_TIME" function created in which the local 

time of the CPU1516F is read out. 

The following parameters should be available when the library-compatible block is called: 

Input Data type Comment 

adrTag Word Start address of the data to be read on the 

transponder 

hwId HW_SUBMODULE Hardware identifier of the IO-Link 

communication module 

length Word Length of the data that is read from 

transponder 

portAdr Int Start address of the connected reader (PCT 

Tool) 

Execute_Data_Read BOOL Read job activated at positive edge 

Execute_Data_Write BOOL Write job activated at positive edge 

Output   

Error 

Bool 
FALSE, if a command was completed without 

errors; TRUE, if an error occurs when 

processing 

InOut   

Ident_Data_Read "User-defined data 

type_User data" 

Area in the S7-CPU where the read data is 

stored 

Ident_Data_Write 

" User-defined data 

type_User data " 

Area in the S7-CPU where the data written to 

the transponder is stored 

Update the function block (FB) "Read_Write_RFID_Data" call in the "Main" organization block 

call and connect the parameters. 

In the Touch Panel TP700 Comfort, change the tag access in the "RFID-Data" screen of the 2 

"Buttons" for the input tags "Execute_Data_Read" and "Execute_Data_Write" from the 

"Read_Write_RFID_Data_DB" instance DB. 
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In the "DATE_TIME" function, the current date and also the current time are to be made 

available as "OUTPUT" parameters and written to the user data of the "Data_Ident_Write" data 

block when the function is called. 

Finally, the operator only has to enter the order number and number of plastic parts at the HMI 

panel. 

8.2 Planning 

Plan the implementation of the task on your own. 

Note:  

– Refer to the manuals or to Module SCE_EN_032-200 FB- Programming about library-

compatible blocks. 

– Refer to the online help to learn how to use the extended instructions of SIMATIC S7-1500. 

Especially in terms of date and time. 

– Also note the time settings in the hardware configuration of the CPU1516F. 

8.3 Checklist – Exercise 

The following checklist helps trainees/students to independently check whether all steps of the 

exercise have been carefully completed and enables them to successfully complete the module 

on their own. 

No. Description Checked 

1 Compiling successful and without error message  

2 Download successful and without error message  

3 
Display of the current date and time on the HMI panel in the 

"RFID-Data" screen 
 

4 Project successfully archived  
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9 Additional information 

You can find additional information as an orientation aid to familiarize yourself or deepen your 

knowledge, for example: Getting Started, videos, tutorials, apps, manuals, programming 

guidelines and trial software/firmware, at the following link:   

 

siemens.com/sce/rfid 

 

Preview "Additional information"  

 

 

 

 

 

 

 

 

 

http://www.siemens.com/sce/rfid
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Additional information 

Siemens Automation Cooperates with Education 

siemens.com/sce 

SCE Learn-/Training Document 

siemens.com/sce/module 

SCE Trainer Packages 

siemens.com/sce/tp 

SCE Contact Partners  

siemens.com/sce/contact 

Digital Enterprise 

siemens.com/digital-enterprise 

Industrie 4.0  

siemens.com/future-of-manufacturing 

Totally Integrated Automation (TIA) 

siemens.com/tia 

TIA Portal 

siemens.com/tia-portal 

SIMATIC Controller 

siemens.com/controller 

SIMATIC Technical Documentation  

siemens.com/simatic-docu 

Industry Online Support 

support.industry.siemens.com 

Industry Mall catalog and ordering system  

mall.industry.siemens.com 
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